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If you are not satisfied with any Gopher purchase for any  
reason at any time, contact us and we will replace the  

product, credit your account, or refund the purchase price.

Read instructions in their entirety. In the event of missing parts, call 1-800-533-0446.

Thank you for purchasing this product from Gopher.

Thank you for your purchase of the new FITstep™ Pro data reader and software. Before you begin, please register your FITstep™ Pro 
at www.gophersport.com/registermyfitsteppro so that we can keep you informed of important software updates.

Operating System Requirements

Operating System Windows® XP SP3, Windows Vista®, Windows® 7, Windows® 8, Windows® 8.1

Item Minimum Recommended

Processor Intel® Pentium® 400MHz Any 1GHz or faster 32 or 64 bit

Memory Capability 512M 1G+

Free Hard Drive Space 100mb 500mb

Installing the Software

To download the FITstep™ Pro software go to www.gophersport.com/software. Click the Windows Version 2 User Software 
Download (FitStepSetup.msi) file and it will install as you follow the prompts. 

The file will first check to see if your PC is ready for a successful install. In some cases, you will be asked to install the Microsoft 
.NET Framework 4 Extended software. The link for the .NET Framework software is: http://www.microsoft.com/en-us/download/
details.aspx?id=17851. Install the software and restart your computer. Click the Windows Version 2 User Software Download 
(FitStepSetup.msi) file again and it will install. 

A Gopher FITstep™ Version 2 icon will be placed on your desktop for easy startup. Please use only this icon. If you already have the 
previous FITstep™ Pro software, as part of the installation process any data you collected with the first version of the software will be 
converted to work with this version. It is not necessary to re-enter all your student information and pedometer numbers.

Setting up the Data Readers

Data readers must been connected to the computer’s USB port. Start the computer, then insert the data reader in the USB port and 
wait for the computer to recognize the new hardware. The reader is ready to use when the red light on top of the dock is on. Repeat 
this process for as many readers as you wish to use. 

The software will recognize multiple readers (we have used as many as 12 successfully). To use additional readers, a USB hub is 
required. If you are using more than 6 readers, you will need a powered HUB (most USB hubs are sold with a power supply). It takes a 
short time for each reader to be acknowledged by the computer. 

Using the Software Menu

The screen pictured on the next page appears when the software opens. The components in the menu bar are used for file operations, 
printing, and importing and exporting data. 

The screen is divided into two major parts. The left window is hierarchical and breaks down by instructor to grades to classes to 
students. To make the next level appear, double click on the top level tile or click on the triangle to the left of the level title. To use any 
of the tabs on the right side of the screen, a class of students must be selected. 

It is possible to utilize the Reports Tab functions with more than one class by holding the control key down and clicking the names of 
the desired classes. A range of items can be selected by holding the shift key down, clicking the first item in the range, and clicking the 
last item in the range.

Microsoft® Windows® Software Manual 
for FITstep™ Pro Version 2
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File Menu

The File menu allows you to create a new database, open an existing database, and print reports. 

If you have not previously stored pedometer data using earlier versions of the software, use the New Database command to name 
and designate where you are going to store your data. If multiple teachers are using the same computer, each should create a new 
database of their own. This way each user can open their database when they are ready to collect data or print reports. It is possible 
for multiple teachers to share the same database. The disadvantage of this approach is that it gives all teachers access to others’ data. 
The advantage is that students can be moved from one teacher to another easily.

If you used the first version of the FITstep™ Pro software, your data will be automatically converted so it works with this software. 
When you click Open Database, your original database will be listed as pedometerData.db. Open it and your data will be in the 
window on the left side. Click on the triangle or double-click on the title to find your classes. All FITstep™ databases are stored as *.db 
files. The default directory for these databases is C:\ProgramData\Gopher\FITstepPro\. However, you can put the database file in any 
directory you wish. Use the File, Open option to select and use a different database.

The Print function is also listed under the File menu. It is only available, however, when students have been selected and data is listed 
onscreen. Click on the print command to see a preview of your report. If you are satisfied with what you see, click on the print icon to 
print the report. If not, cancel the report and filter the data as you prefer. Another feature of the ReportViewer is that you can save 
your report in many different formats, including a PDF and a Word document. To do so, click on the triangle to the right of the floppy 
disc on the command bar of the report and pull down your desired formatting.
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Import/Export Menu

The Import/Export menu is used to export the full database to Excel and to import students into a class. The Import Students into 
Class command is used to import student information into the database. For example, if you have access to student roll sheets in an 
Excel spreadsheet, you can use this menu to upload their names and pedometer numbers into your database. To import correctly, 
ensure both first and last names are entered and every record is complete. You do not have to include the entire text of each student’s 
name (i.e., Joe Smith could be entered as Joe S). An additional option is to assign a student number or enter a school database 
number. 

Data Menu

The Data menu serves one function only, but it is an important one. If the box is checked, pedometer data is cleared after it has been 
placed in the USB port and uploaded. If the box is not checked, the pedometer data will be uploaded but not cleared. Not clearing 
pedometer data after each upload presents the possibility for students to upload data multiple times. The program defaults to “Clear 
Pedometer on Read” each time it is loaded.

Using the Tabs

To manage your use of the FITstep™ Pro pedometers, use the Class Setup, Upload Pedometer, Pedometer Setup, and Reports tabs. 
Each of the four tabs is discussed below.

Class Setup Tab

The Class Setup Tab is the control center. This tab is where you will add new instructors, grades, classes, and finally students. All 
fields, such as the instructor number and description fields, do not have to be filled. Notice how the data is organized. The top field is 
the Instructor, usually the Physical Education teacher. Next is Grade followed by the Class Name, which might be listed as a classroom 
teacher in an elementary school or as a numbered class in secondary schools (i.e., 3rd Period). If desired, type in a description of the 
class with information that might be relevant. Finally, in the last section, add the students by first and last name, gender (optional), and 
pedometer number. If desired, a student ID number can also be added. 
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Upload Pedometer Tab

The Upload Pedometer Tab is used to upload pedometer data from the data readers. Reminder: Select the proper class before 
uploading or data may not be uploaded to the correct class. If a class is not selected, the software will not allow uploading of data. 
Students upload their data by inserting and placing the pedometer into the reader. While the data is uploading to the computer, the red 
and green lights flash. When the uploading is complete, only the red light stays solidly lit. (This takes about two full seconds.) Note the 
screen shot on the next page which shows students listed in three different color fonts during the uploading process:

1.	 The black font signifies that students have not uploaded their data.

2.	 The light green font signals that data has been uploaded and the pedometer cleared.

3.	 The red font means the data was not uploaded even though the student inserted the pedometer into the USB port. In most cases, 
this occurs because the student improperly inserted the pedometer or removed it before the uploading process was complete.
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IMPORTANT: The key to successfully uploading data is to not take the pedometer out of the reader before the red and green 
lights stop flashing. To ensure the data has been uploaded, ask students to continue to insert their pedometers until they 
clear. When pedometers are removed prematurely, the lights on the reader show different patterns, such as solid green, 
no lights on, or both lights on continuously. Don’t unplug the readers or assume they will no longer load data. Instead, ask 
students to continue to reinsert the pedometers until the data is uploaded and the pedometer cleared to zero.

Pedometer Setup Tab

The Pedometer Setup Tab has one purpose: to embed a number in the pedometer. New pedometers arrive with the number zero (0). 
Thus, it is recommended that you embed pedometer numbers before using them with students. Here is a suggested procedure for 
numbering the pedometers if you have a new set:

1.	 Number the pedometers on the outside and inside of the pedometer covers. This will make it easy for students to identify their 
pedometers each time they come to class. It is probably easiest to start with pedometer 1 and number from that point forward. 
However, numbering can be started with any integer.

2.	 Click on the Pedometer Setup tab. The current pedometer number will be listed as 0. Click on the “Write New Number” box. Set 
the new pedometer number to the desired starting number. For example, if you set the new number to 1, that pedometer will be 
internally assigned the number 1. Place the pedometer you have externally numbered as 1 in the reader. Wait until the lights stop 
flashing to remove the pedometer. 

3.	 The software will automatically change the next pedometer number to 2. You are now ready to insert pedometer 2 because the 
software automatically increases to the next integer.

4.	 To check whether the correct number has been assigned to the pedometer, press the Mode (blue) button on the pedometer until 
the Step screen is showing. Now hold down the Set (red) button to see the pedometer number. It will show as P=00001 if you 
embedded number 1. Note: Nothing will show on this screen if the pedometer is set to zero (like all new pedometers).

5.	 To manually change a pedometer number, check the “Write New Number” box and type in a new number. Reinsert the 
pedometer into the reader and the new number will be uploaded. A pedometer number can only be changed using the Setup 
Pedometer tab.
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Reports Tab

The Reports Tab is your data center. Click on the Reports tab to see different types of reports. All of the reports can be printed and 
sorted. Different columns can be selected by checking the boxes on the right side of the screen.

1.	 Sorting: The default order of sort is by name in ascending order. To sort any column in descending order, click on the title of the 
column you want to sort and the order will be reversed. Click again and it will return to ascending order. Sorting will move entire 
records, not just the column you clicked on.

2.	 Date Range: You may choose the date range for all the reports. In other words, if you only want to view data from May 1 to June 
1, select it by typing in the dates or clicking the desired dates on the calendars to the right.

3.	 Columns: Select the columns you would like to show in your reports.

Brief Description of Reports

Students may upload their data multiple times during the day. When the program calculates daily average for each student, it will add 
together all uploads accumulated in a single day. To preview reports before printing, click on the file menu and select Print. 

1.	 The Workouts report shows all uploads for each student. Every time a student uploads data, it is stored as a workout. 

2.	 The Weekly Summary report shows each student and their workouts by week. This allows you to analyze students and your 
lessons on a week-by-week basis.

3.	 The Monthly Summary shows each student and their monthly total and averages.

4.	 Class Roster offers you the opportunity to print out a list of your students by class. You can print a number of classes per print job 
by control-clicking on selected classes.

5.	 The My Physical Activity report allows you to print a physical activity report for each student. The report contains a message to 
parents and students along with the selected activity data (see below).

Future updates of the FITstep™ Pro software will be available for download at: www.gophersport.com/software.

www.gophersport.com/software

